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1. Introduction
FragmentAlign is developed for data analyses of metabolome data obtained by gas chromatography
(GC) - mass spectrometory (MS). The metabolites detected by electron ionization (EI) of GC-MS are
observed as sets of ion products (fragments) which are specific to the originated metabolites.
FragmentAlign compares the pattern of the ion fragments between the metabolite peaks observed in
the different samples, aligns the peaks and then generates a data matrix which can be used as
comparative analysis of metabolite amounts and multivariate analyses such as principal component
analysis (PCA). By creating a data library of ion fragments of standard chemicals, the metabolite
peaks detected by the same GC-MS instrument can be identified or annotated. FragmentAlign
provides both of the functions for library construction and searching. One of unique functions of
FragmentAlign is a powerful editing and correcting function of the alignment results, which
facilitates researchers to prepare curated data matrices for further careful investigations of the
metabolome data. The alignment data created by the other tools can be imported into FragmentAlign
to edit and refine the alignment results. The tool is designed to accept text-formatted file as input,
enables to process data of any GC-MS instruments as long as the data can be converted to the defined
text format.

1-1. System Requirements
The operation of FragmentAlign has been testes in the following computer settings.

OS:
Microsoft Windows XP, Vista, 7 (32 bit), 7 (64 bit)

Software:
Java Runtime Environment ver.1.6.0_14

1-1-1. Installation of Java Runtime Environment
Your PC has to have Java Runtime Environment (JRE, ver. 1.6 or higher) setup to run FragmentAlign.
If you don't have it done, install the latest version of JRE 6 or higher according to the web site
(http://java.sun.com/javase/downloads/index.jsp).

1-2. Installation
Download the compressed package of FragmentAlign from:
http://www.kazusa.or.jp/komics/software/FragmentAlign/
Decompress the downloaded file. The following files and folders will appear.

|-

FragmentAlign_VERSION
|FAlign.jar
|FragmentAlign.jar
|FragmentAlignRun.bat
|readme.txt

To run the sowtware double click "FragmentAlignRun.bat".
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1-2-1. Advanced Settings
You can modify the execute options of the java program to get better performance of FragmentAlign
in your PC environment.
Open the file "FragmentAlignRun.bat" with a text editor such as notepad.exe.
java -Xmx128M -Xmx512M -jar FragmentAlign.jar
The option "-Xmx" defines the maximum memory size that the program uses. Setting a larger size to
it, more files can be open for alignment. If most of the other software are not running, we recommend
to set the same value to "-Xms" option too, which defines a memory size that the program initially
keeps.
ex)
java -Xmx1024M -Xmx1024M -jar FragmentAlign.jar
Save the file and double click to start FragmentAlign.
In the 32 bit OS, a half of the main RAM size of your PC is recommended for the maximum value of
the "-Xmx" option, ex. 1000M is recommended for 2 GB PC. However, a substantial limit seems to
be around 1400M even on the 4 GB PC under 32 bit environment. When a larger value than the limit
is set, FragmentAlign doesn't start.
If you need more memory to analyze many samples, run FragmentAlign on a 64 bit OS where larger
size (> 2000M ) can be set.

1-3. Tutorials
A set of tutorial data files is available at the FragmentAlign distribution web site
(http://www.kazusa.or.jp/komics/software/FragmentAlign/). It would help the users to learn the
functions of the tool quickly.
This manual includes some tutorials like below. Use the data files with the tutorials.
Tutorial:
Visit the FragmentAlign distribution site at
http://www.kazusa.or.jp/komics/software/FragmentAlign/.
Download the tutorial data set and decompress it on your PC.
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2. Overview of the Functions
2-1. Main Window
The main window of the FragmentAlign is shown below. All the functions are accessed through the
buttons on the main window.
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1) Open or Create Project
At the first step of the analysis, users have to select a data folder where FragmentAlign saves
processed files properly. The folder is referred as "project home directory" in this manual. Users can
create a new home directory to initiate a new data analysis, or select an existing home directory to
resume the data analysis.

2) Data Import
In the FragmentAlign, peak data from GC-MS are processed and saved in an extended version of
NIST MSP format (we refer it the "FragmentAlign format" or "FA format" in this document, see 5-1.
FragmentAlign format). Through the Data Import function, data files written in some other formats
are converted to the FA format and copied to the current project home. Currently the function
supports the data files available from GMD database of MaxPlanck Institute
(http://csbdb.mpimp-golm.mpg.de/csbdb/gmd/gmd.html) and the MST files provided by
MassBase (http://webs2.kazusa.or.jp/massbase/).

3) Deconvolution of raw data
FragmentAlign provides a simple tool to deconvolute the raw data and generate peak data in
FragmentAlign format. The file must be written in the format same as the CSV (comma separated
vector) formatted file exported by ChromaTOF software (LECO Corporation).

4) Retention Indexing
In GC-MS analysis, length of the capillary column affects to the retention time of the materials.
Retention time of the peaks can be converted to retention indices using a reference data obtained with
a set of standard compounds. A series of linear alkane compounds in different carbon numbers is
commonly used. FragmentAlign provides a function of the indexing of retention time.

5) Peak Viewer
3

Peaks and their intensities are graphically displayed along time axis. Checking of fragmentation
patterns, normalization of the peak intensities based on a selected peak (such as the peak of internal
standard), and searching against a standard library can be available through the function.

6) Peak Alignment and Editting
FragmentAlign provides a simple alignment algorithm using the similarity of the fragmentation
patterns. It also serves a powerful environment to the researchers by which the alignment results can
be edited and corrected manually through the GUI. The peaks can be identified and annotated using
the standard chemical library. The alignment data created by the other tools can be imported into
FragmentAlign to edit and curate the alignment data with the GUI.

7) Standard Chemical Library
Users can check the library of the fragmentation patterns of the standard chemicals, which is used for
identification and annotation of the detected peaks.
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3. Details of the Functions
This chapter introduces all the functions of the FragmentAlign in detail. The sections are arranged
along with the major workflow of the analysis. "Tutorial" guides the examples of the operations.

3-1. Project Management
A set of data files for a purpose of data analysis is managed by FragmentAlign in a folder in your PC
(the project home directory). For the first step of data analysis in FragmentAlign, users have to create
or choose a project home directory where input files and all the files processed by FragmentAlign are
placed. Several sub-folders with prefixed names are created automatically when the project home
directory is created.
Table 3-1 Sub-directories created under the project home directory
sampleData
Sample data files are placed here.
Sample data files with normalized peak intensities (created with PeakView
normalizedData
function) are saved here.
refData
Reference data file for retention time indexing is saved here.
Data files of the endogenously detected internal standard metabolites for the
endoIsData
fine alignment are saved here.
libraryData
A directory for Standard Compound Library data files.
results
Alignment results exported here as a set of data files.

3-1-1. Creating a Project
Press "Open/Create Project" button on the Main Window, and select a directory. If the
system-required sub-directories are not found, FragmentAlign creates them automatically.

3-1-2. Opening an existing Project
Press "Open/Create Project" button on the Main Window, and select a directory. If the
system-required sub-directories are found, FragmentAlign opens the directory as an existing project.
If a valid project home directory is selected, the name of the directory is displayed in the "Home Dir:"
area, and it is ready to start analyses in FragmentAlign.
Note:
Users can copy, move and rename the project home directory, but don't delete or rename the
sub-directories and the files included in them.
Tutorial:
Create a new project home directory named "TestProject" on your PC and open it.

3-2. Data Importing
The data files that are processed with FragmentAlign have to be written in the FragmentAlign format,
which is a kind of NIST MSP format (see 5-1. FragmentAlign format in details).
The data importing function in FragmentAlign provides followings.
- Copying the existing FA formatted-data into the project home directory.
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- Converting "MassBase MST" data (http://webs2.kazusa.or.jp/massbase) into the FA
formatted-data, and placing them under the project home directory.
- Converting the data files provided by the GMD database of MaxPlanck Institute
(http://csbdb.mpimp-golm.mpg.de/csbdb/gmd/gmd.html) into the FA format, and placing them
under the project home directory.
- Converting the ".ELU" file intermediately generated by AMDIS software
(http://chemdata.nist.gov/mass-spc/amdis/) into the FA format, and placing them under the
project home directory. Only the peak models labeled with "TIC" or "MP1" are converted. The
value in "Intgr. Signal" is adopted for peak intensity.
The imported and converted data are saved in the "sampleData" folder under the project home
directory. A prefix "FA_" is added to the head of the file names which are converted from MassBase
and GMD.

3-2-1. Importing Data Files
After selecting a project home directory click "Import Other Data" button on the Main Window. The
Data Import window appears.

Select the data files from "Select Files" button. The file names are displayed in the "File Names" area.
Select the file format of them from the "Format" pull-down menu.

Press the "Import All Files" to import all the files selected. The progress is displayed at the status bar
and the process finished with the message below.

The imported files are stored in the "sampleData" folder under the project home.
If problems happened, the following message appears.
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Click "Details" button to check the errors in detail.

You can check the file importing for a file. Select a single file from the "File Names" area, and push
the "Test" button. Only the selected file is imported.

Tutorial:
Select three files from the "DataImporting/MassBaseMSTFormat" folder in the tutorial data (see 1-3.
Tutorials), select "MassBase MST" from the "Fromat" pull-down list, and press "Import All Files".
Check the directory "project home/sampleData". You can see three files which names start with
"FA_".
Advanced:
Users can put the data files in FragmentAlign format in the "project home/sampleData" folder directly
by manual file operations on the OS.

3-3. Deconvolution of raw data in CSV file
FragmentAlign can read a "raw mass chromatogram data" in comma separated vector (CSV)
formatted text file, performs deconvolution of mass peaks, and outputs them as a set of peaks in a FA
formatted file. The format of the "raw mass chromatogram data" is the same as that of CSV file
exported by the ChromaTOF software (LECO Corporation) (see 5-2. CSV File Format for Data
Deconvolution).
As the deconvolution algorithm implemented in FragmentAlign is not so robust, it occasionally
would happen that some ion fragments derived from a single metabolite are distributed into two
independent peaks. We have obtained good results with the deconvoluted data by FragmentAlign
when it used for the comparison of metabolite profiles such as principal component analysis (PCA).
But if in the case of researches of much strict peak identification is required, we recommend to use a
reliable software/algorithm such as AMDIS (http://chemdata.nist.gov/mass-spc/amdis/) and
deconvolution function in ChromaTOF, and then convert it to FragmentAlign format.
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3-3-1. The Deconvolution Algorithm
Each ion has three values, briefly, retention time, mass value, and intensity. All the ions detected by
the instrument are described in the CSV raw data file.
1. The ions having low intensity are filtered out.
2. The ions are binned into nominal mass chromatograms.
3. Each mass chromatogram is smoothed by the mean filter for the time axis. The intensity of an ion
at a scan point is calculated as the average value of intensities of several ions which are detected
just before and just after the scan point.
4. The mass peaks are detected for each nominal mass chromatogram.
5. The mass peaks whose peak top scan points are the same or one neighbor point are grouped and
assigned as a metabolite peak. Each grouped mass peaks is considered to be an ion fragment of the
metabolite peak. The retention time of the metabolite peak is the average of the peak top time of
the grouped mass peaks. The intensity of the ion fragment is calculated as the integral value of the
mass peak dimension.

3-3-2. Perform Deconvolution
Click the "CSV Deconvolution" button on the main window to open the sub window.

* This window opens without selecting the project home directory.
Click the "Select Files" button to select CVS files. The file names and the folder name are displayed
on the window.

Set the parameters.
 Intensity threshold:
The ions with intensities less than the threshold are omitted before the mass peak detection (see The
Deconvolution Algorithm). The threshold value is calculated by the given ratio and the maximum ion
intensity in the raw data. If zero is set as the ratio, no ion is filtered out.
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 Point number for smoothig:
Users can set the number of the scan points involved in the average calculation for mass
chromatogram smoothing (see The Deconvolution Algorithm). When nine is given, the averaged ion
intensity at a scan point is calculated with each four neighbors detected before and after the scan point
and the scan point itself. The parameter largely depends on the scan speed of the mass spectrometer.
Press the "Deconvolution" button to perform the deconvolution. If the project home directory has
been selected and "Output to the Project Home Dir. " is checked the resulted files are saved in the
"project home/sampleData" folder.
The prefix "FA_" and the postfix "([Point Num.] - [Threshold Ratio] )" are attached to the name of
the resulted file.
ex)
ArabidopsisLeaf_A(P)_1.csv -->

FA_ArabidopsisLeaf_A(P)_1(9-1.0E-4).txt

Tutorial:
Find the CSV file in the tutorial data (see 1-3. Tutorials) named " GCMSRawData_example.csv"
which you can find in the "CsvDeconvolution" folder. Execute deconvolution with the file and the
default parameter settings. Find the resulted file named "FA_GCMSRawData_example(9-1.0E-4).txt"
in the "sampleData" folder of your project home directory.

3-4. Retention Time Indexing
The maintenance of a GC-MS instrument includes cut and replace of the capillary column. Therefore
the retention time of a material could be change between before and after maintenance, even if the
same sample is analyzed with the same instrumental conditions and procedures. To ensure arbitral
comparison between data obtained at anytime and anywhere, retention times of the peaks are
converted to some indices (here we call this as retention time indexing). A series of linear-alkane
compounds is usually used as a standard. An extra run of the alkane mixture is conducted before or
after the target sample analyses to measure the retention time of the alkanes under the same analytical
conditions with the target samples. The retention time of Cn alkane peak can be defined as an index n
x 100 (ex, C12 as 1200, C14 as 1400). Then all the retention times of the metabolite peaks in the
target samples can be converted to the index.
The function for retention time indexing in FragmentAlign is separated into two steps.
Step 1: Defining the indices of the standard compound peaks --> "Ref. Data Manager" button.
Step 2: Indexing of the retention times of the peaks --> "Retention Indexing" button.

Step 1

Step 2
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3-4-1. Reference Data Manager
Select the project home directory and click "Ref. Data Manager" button. The following window
appears for defining retention indices using a data of standard compounds.

Click "Open Ref Data" button and select a data file of the mixture of standard compounds. The data
files have to be formatted in the FragmentAlign format.

Make a "Ref Peaks" list as follows.
1) Select a peak attributed to the standard compound from the chromatogram at the top-right where
the retention times of the peak (X-axis) and the intensity (Y-axis) are represented. The following
operations on the panel helps to do this.
Left-click: Selecting a peak.
Right-drag: Zooming in the dragged area.
Right-click: Zooming out.
The selected peak is displayed as blue line, and the retention time is highlighted in the "Peak RT"
list. The fragmented ions generated by electron ionization (EI) are shown in the bottom-right panel
where m/z of the ions (X-axis) and their intensities (Y-axis) are represented.
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2) Click "Add" button on the bottom-left.
The retention time of the selected peak is added to the "Ref. Peaks" list. The initial value of the RI
of the new entry is zero.
3) Double click on the cell at the RI column of the list to enter the edit mode. Enter a proper index
and then press enter key.

Click "Save" button after assigning the indices to the picked standard peaks. The result is saved in the
"project home/refData" folder. Here after the resulted file is called the "reference file".

The FragmentAlign file used for the creation of the reference file was copied in the "project
home/refData" folder. The default name of the reference file is the one that the prefix "Ref" is
attached at the head of the originated data file.
ex)
FA_AlkaneStandard.txt

-> RefFA_AlkaneStandard.txt

Note:
When saving the reference file, users can change the file name as they like. But the default file name
is better because the users can re-edit the reference file (see next).
Tutorial:
Open the file named "FA_AlkaneStandard_example.txt" in "RetentionTimeIndexing" folder of the
tutorial data (see 1-3. Tutorials). Select the peaks of the alkanes and attach the retention indices for
them. Save the reference file.
In the "RetentionTimeIndexing" folder, you can find the example of the reference file
("RefFA_AlkaneStandard_example.txt"). Open the file with a text editor and check the values.

3-4-1-1. Re-editing of the Reference File
Users can re-edit the reference file. Click the "Open Ref Data" button to open the FragmentAlign file
from the "project Home/refData" folder. If there is the reference file which name starts with "Ref" and
rest is the same as the data file in the "refData" folder, the Reference Data Manager loads the
reference file data and displays the results automatically. Continue to edit the data and save it again.

3-4-2. Retention Time Indexing
Using the reference file created by the "Ref. Data Manager", the retention indices of the peaks in the
sample data files are calculated by linear interpolation.
Click the "Retention Indexing" button on the main window after selecting the Project Home
Directory.

11

Select sample data files by clicking "Select Sample Files" button. Also select the reference file
created with the Ref. Data Manager with "Select Ref. File" button.

Click "Do Indexing" button.
If "Overwrite" is checked, the calculated retention indices are overwritten in the original data files the
users opened above. If it's unchecked, the resulted files with retention index information are saved in
the "sampleDataRI" folder in the Project Home Directory.
Tutorial:
Select the reference file and the deconvoluted file you prepared in the previous tutorials (page 8 and
page 10) and perform indexing without checking the "Overwrite" checkbox. Find the resulted file in
the "sampleDataRI" folder.

3-5. Peak Viewer
The peaks and their intensities are displayed graphically on the Peak Viewer Window, facilitates users
to check the detected peaks. The ion fragments of the metabolite peak are also visualized. Peak
Viewer provides the following other functions.
 Normalize
Normalization of the peak intensities for further analyses of data comparison.
 Search
Searching in the Standard Compound Library to find metabolites which have similar EI fragmentation
patterns to the selected peak.
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 Annotation
Library searching for all peaks and attaching the result to each peak automatically.
Users can attach short comments to the peaks and are allowed to modify the peak names. The edited
result can be saved in a file.

3-5-1. Loading Data Files
Click "Peak Viewer" button on the FragmentAlign main window after selecting the Project Home
Directory. The Peak Viewer window appears.
Click "Open Files" and select one or more files. The selected file names are listed in the "Sample"
list.

Select a proper format from "File Format" pull-down list and click a file name on the "Sample" list.
The peaks in the files are displayed on the upper right panel where the retention time (X-axis) and the
intensities (Y-axis) of the peaks are represented.

3-5-2. Viewing Peaks
Click on the peak view panel (upper right), then the selected peak is highlighted in blue. The name,
short comment and the EI fragmentation pattern of the peak are displayed on the fragmentation panel
(bottom right).
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Peak Name

Y-axis: intensity

Comment and Peak
Name Save Button
Short comment

X-axis: m/z

List of m/z of EI fragment ions
sorted by the intensity

Graphical representation of EI
fragment ions

Users can edit the name and comment of the selected peak by modifying the texts directly and then
clicking the "Save" button. The modification is memorized temporarily by the system and written in a
file by "Save File" operation (described later).

3-5-3. Normalization of Peak Intensities
FragmentAlign provides a normalization method of the metabolite peaks that is based on the intensity
of an internal peak user selected. In the GC-MS analyses, researchers often add known amount of the
internal standard (IS) compound to the samples for later quantification of the metabolite peaks. The
normalization function in FragmentAlign is suitable to such cases, because users can easily identify
the IS peak viewing the graphical representation of EI fragmentation patterns.
Find and select the IS peak. Check the pattern of EI fragmentation ions to verify wheather the peak
was surely derived from the IS compound.
Click the "Normalize" tab at the bottom left of the Peak Viewer window.

Enter a value in the text box and click "Normalize" button. The intensity of the peak is normalized
according to the next formula.
Intnorm = Value x Intorg / IntIS
, where Intnorm is the normalized peak intensity, Value is the user-input value, Intorg is the original peak
intensity, and IntIS is the original intensity of the IS peak.
The normalized peak data is exported automatically in the "Project Home Directory/normalizedData"
folder with the file name same as the original.
Notice:
After performing the Normalization, the data displayed on the Peak Viewer is switched to the
"normalized" file. Therefore, the modification of names and comments of the peaks are to be saved to
the "normalized" file.
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3-5-4. Searching with Standard Compound Library
The Standard Compound Library is a data set of EI fragmentation patterns of the standard compounds.
By comparing the pattern of the user-selected peak with those of standard compounds in the library,
researchers can identify and/or speculate (annotate) the metabolites of the peak. It gives better results
if the standard library is constructed by the user under the same instrumental settings to the sample
analyses, because the retention indices of the library and the sample peaks would be perfectly
compatible. However, the construction of standard compound library is quite laborious, time
consuming, and requires huge cost. When users utilize public data libraries such as NIST library, the
retention index might be excluded from the searching parameters.
Click "Search" tab.

Push "Open lib." button. The library setting window appears. Set the library files and matching
parameters according to the section 3-7. Standard Compound Library.
Select a peak from the top-right window and click "Search This Peak" button. The compounds
matched with greater score than the user input-cutoff value are listed.

By clicking on the result list, the fragmentation pattern of the standard compound is displayed on the
Standard Compound Library window.

15

3-5-5. Annotation - Library Searching for All Peaks
All the peaks in the selected data is searched against the Standard Compound Library, and the
information of the best hit compound that has more than the "Score Cutoff " is attached to the peak
comment. The standard compound library has to be selected prior to the operation.
Input cutoff value and press "Do Annotation for All Peaks" button. If "Overwrite" button is selected,
the current comment of the peak is replaced by the new result. If "Add anyway" is selected, the result
is appended to the current comment.

The result includes the hit score and the compound name like as shown below.

Users can delete comments of all the peaks by clicking "Delete All Annotations" button.
The modification operated by this function is stored temporarily by the system. Save the results in a
file by the "Save File" function.

3-5-6. Saveing the Modification in a File
Users can edit the name and comment of the peaks by clicking the "Save" button on the bottom-right
panel and by the "Annotation" function. The results of these operations are temporarily memorized by
the system, and it is vanishing by selecting other sample data or closing the Peak Viewer window.
Save the modifications in a file by "Save File" function.
After editing the data, just push "Do Save This File" button on the "Save File" tab. The file save
dialog appears. Input the file name to save.
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If "Overwrite to the original file" is checked, the modifications are overwritten on the file currently
selected.

3-6. Peak Alignment, Editing, and Peak Annotation
The Peak Alignment Window appears by clicking "Peak Alignment" button after selecting the Project
Home Directory.

The users can perform,
1) alignment of the peaks in multiple data files based on their EI fragmentation patterns,
2) editing of the alignment results referring the EI fragmentation patterns,
3) annotating the metabolites by Standard Compound Library searching,
4) outputting the resulted data to files, and
5) importing the alignment data created by the other tools to edit the results with the GUI of
FragmentAlign.

3-6-1. Alignment of the Peaks
The alignment procedure on FragmentAlign is separated into two-steps. In the first step, the peaks are
aligned to find metabolite peaks which are detected in the all samples (here after we describe them as
"endogenous IS"). Then the time unit of each data is corrected by the endogenous ISs. Users can
choose the endogenous ISs using in the time correction. Users can skip this first alignment if the
analysis was performed under finely controlled conditions and reproducible data were obtained.
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In the second step, the peak alignment using the corrected time are performed, by which much fine
alignment results are expected.

3-6-1-1. First Alignment to find the Endogenous IS
Select the data files by clicking "File" menu and selecting "Open Files". The selected files are listed
in the "Samples" list.

Select the time unit, retention time or retention index according to the selected files.

Click "Other Settings" button to set alignment parameters. The following window appears. It is quite
similar to the parameter setting window for the Standard Compound Library and most of the
parameters are same as it (see 3-7-1. Setting Matching Parameters).

Set the parameters. There are two additional parameters.
 Intensity Cutoff
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The cutoff value is given as the ratio of the maximum peak intensity of each sample data. If one of the
intensity of the peak is smaller than the cutoff value, the peaks are evaluated as not matched (rejected).
If the zero is given for the ratio, no peak is filtered out.
 Matching Mode (Strict or Tolerate)
During the alignment algorithm, matched peaks are grouped. If strict mode is selected, a peak in the
group matches all the other peaks. If tolerate mode is selected, a peak in the group matches at least
one other peak.

Sample A
Sample B
Sample C
Sample D
Sample E
strict mode

tolerate mode

The tolerate mode is suitable to find endogenous ISs.
See 4. Peak Alignment Algorithm for the details of the alignment algorithm.
Press "Find Endo. IS" button to perform the first alignment. The results are displayed on the right
panel.

The time unit (retention time or retention index) is shown in the X-axis and the sample number is
represented in Y-axis. The sample listed at the first line of the "Samples" list is represented at "0.0" in
the right panel, and sample at the second line is at "1.0". The peaks are represented as red dots and
their intensities are visualized with brightness of the color. The green lines represent the aligned peaks,
and their averaged retention times (indices) are listed in the "Time" list. By clicking the item in the
"Time" list, the aligned peaks are highlighted in blue and the retention time of each peak is listed in
the "Peaks" list.

19

Click

icon at top of the alignment panel. The Fragment Viewer window appears.

The EI fragmentation pattern of the selected peak is shown at the upper panel with red lines. The
averaged pattern of the aligned peak group is shown in the bottom panel. By comparing the
fragmentation patterns in the group, users can check whether appropriate peaks are aligned with the
alignment conditions. If unappropriate peaks are included in the group, delete the group by clicking
"Delete" button at the bottom of "Time" list.
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Advanced:
Users can create a new alignment peak groups with the buttons at the bottom of the alignment panel.
Users can also add/remove peaks to/from the alignment peak group. See 3-6-2-2. Editing Functions of
the Alignment for details.

Leave the aligned peak groups which are using for the second alignment. The retention times
(indices) of the peaks in the selected groups are used for the time scale correction in the second
alignment.
Click "File" in the menu and select "Save IS Data Set". The edited results are saved in a file you
named. In default, the IS data is saved in the "Project Home Dir/endoIsData" folder. The file is used
in the second alignment (see below).
Caution:
It is not guaranteed to re-edit the IS data set file. Use the saved IS data set file only for the second
alignment, and don't edit it after loading.

3-6-1-2. Second Alignment (The Main Alignment)
Click "Load IS Data Set" from the "File" menu to load the endogenous IS data set file which is
created and saved above. If the first alignment was skipped, open the data files by selecting "Open
Files" in the "File" menu.
Select the time unit. Click "Other settings" to check and set the alignment conditions. Then click
"Align" button to perform the second alignment. If the IS data is loaded, the time scale of each
sample is corrected by the endogenous ISs at the beginning of the second alignment, by which a
stringent alignment can be done with a narrow time range tolerance.
The results are displayed at the right panel (Alignment Panel).

 Editing of the Alignment Results
Users can edit the alignment results. See 3-6-2-2. Editing Functions of the Alignment where editing
functions are described in detail.
 Data Saving (Output to the files)
Select "Save Alignment Data" in the "File" menu. A file select window appears. Select a folder for
data saving. FragmentAlign create several files in the folder. The folder "Project Home Dir/results" is
created automatically for the parent of the data folder.
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The following files are created.
0_setting.txt
The file path of the original data, the alignment parameters, and some preferences of the alignment
panel are described. If the Project Home Directory or the alignment data folder is moved to
somewhere, users have to edit the file path in this file.
1_peakId.txt
2_peakIntensity.txt
3_peakName.txt
These are tab delimited tables describing alignment results. The number of rows and columns of these
files are the same. The first and the second column is the average value of the retention time and
averaged retention index, and the third column is the comments of the alignment peaks. The values in
the columns named with the data files are as follows.
1_peakId.txt
Peak IDs. The peaks described in the data file is numbered automatically as the first
record is zero. Be careful, the IDs are independent of the "DB#" value in the peak record.
2_peakIntensity.txt
Intensities of the peaks. The file can be used for the further analysis such
as principal component analysis.
3_peakName.txt

Peak names.

4_alignedPeaks.txt
This file is used only for the internal process. The first column is the average of retention time (index)
and the rest of the columns are peak IDs for each file name. The places without peak are filled with
"-1".
FA_AllPeaks.txt
FA_AveragePeaks.txt
FragmentAlign-formatted data file for the peaks in the aligned data. The retention time, retention
index, and the EI fragmentation patterns are averaged in the aligned peak groups.
"FA_AveragePeaks.txt" only contains the averaged data for aligned peak groups, and the "FA_
AllPeaks.txt" contains the averaged data and the other peak data which are not matched to any other
peaks. Be careful that the original intensities of the fragments described in each data file are used for
the average calculation.
RedGMULTI.txt
This file is for the Dr.DMASS software (http://kanaya.naist.jp/DrDMASS/) which equips simple
PCA function.
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The alignment panel is redrawn after saving. If "keep view position" is checked, the alignment panel
keeps the current zooming state.

 Loading the Saved Data
Select "Load Alignment Data" from the "File" menu, and choose the folder name you saved. The
loaded folder name is displayed at the top-left of the Peak Alignment window.

User can re-edit the alignment data. Don't forget to save the results.

3-6-2. The Editing Function of the Alignment Results
By the functions of the Peak Alignment window, users can delete, create and modify the alignment
results. Users are even allowed to merge the adjacent peaks into a single peak.

3-6-2-1. Display Options
Users can customize some settings for the data visualization on the display. It helps users to edit the
alignment results precisely and intuitively.
 Color Strength of the Peaks
On the alignment panel, peaks are represented as small red squares and the intensities are visualized
as the brightness of the color.

Set a larger value for "Color Str:" and press return key. The brightness will be enhanced.
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Check off the "Gradation" check box. Then the peaks are displayed with the maximum brightness.

Small gray squares are the peaks that have smaller number of EI fragment ions than the "Minimum
Fragment Number" set on the "Other Settings" window for the alignment.
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 Advanced Setting of the Color strength
The default color strength of the peaks is based on the maximum peak intensity of each data file. Here
after we call the peak used for the color settings as "Base Color Peak ". Users can change the Base
Color Peak for each data. For example, by selecting the internal standard peaks as Base Color Peaks,
relative intensities across the samples can be visualized.
The brightness B of the peak is calculated as following formula.
B = (the intensity of the peak / intensity of the Base Color Peak ) * 255 * value of "Color Str"
, if B exceeds 255, B is set to 255.
Click the

icon at the top of the window. The "Base Color Settings" window appears.

The ID of the Base Color Peak currently used is listed in the "Base Peak ID" column on the table. In
default, the Base Color Peak is the peak having maximum intensities in each sample, therefore, the "is
Max Peak" column checked.
On the alignment panel, select an arbitral peak which you want to set as the Base Color Peak. The
crossing point of the light-blue cursors represents the currently selected peak.

Then click "Peak" button on the Base Color Settings window. The Base Color Peak ID is switched to
the selected peak ID on the table, and the color gradation on the alignment panel is redrawn.
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When an aligned peak group is selected (represented in blue) on the alignment panel, and "Group"
button on the Base Color Settings window is clicked, the Base Color Peaks for all the samples
corresponding to the peaks included in the aligned peak group are set to the selected ones.
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To restore the default, click "Set default all" button on the Base Color Settings window. When a row
on the table is selected and "Set default this row" button is clicked, only the sample data of the
selected row is restored to the default color setting.
 Setting of the View Area
By dragging on the alignment panel with the left button of the mouse, the dragged area is magnified
(Zoom In). Clicking the panel with right button zooms out.
Users can set the viewing area by the values. Click "Area..." button at the bottom of the panel.

The Area Settings window appears. Set ranges of the retention time (index), sample number and click
"Redraw" button.

 Scrolling
When zooming in, the scroll bar for time-axis appears. Drag the handler to scroll the view area left or
right.
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Alternatively, click "Move Left" or "Move Right" button to scroll the area left or right.

The width of the scrolling is defined by the ratio of the current area width. If the "Step" value is set to
"1/10", the view area is scrolled 10% of the area width left/right for every clicking of the move
button.

3-6-2-2. Editing Functions of the Alignment
 Anchoring a Peak
Double click at the peak symbol. The peak is marked with a blue circle. We call the peak "Anchored
Peak." The information of the anchored peak is temporarily memorized by the system, and the users
can compare the characteristics of it with any other peaks.

Double click on another peak to switch the anchored peak. To cancel the anchoring, double click
again on the anchored peak.
 Data comparison between the peaks
Click
icon at top of the alignment panel. The Fragment Viewer window appears. The lower
panel of the window shows the EI fragmentation pattern of the anchored peak with blue lines.
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Click another peak you like on the Alignment Panel. The data on the upper panel of the Fragment
Viewer window is changed.

As you can see in this figure, the anchored peak and the selected peak have similar fragmentation
patterns. Therefore, these peaks can be treated as a new alignment group.
Click

button at the top of the alignment panel. The "Tools" window appears.

On the "Compare" tab users can check the each correlation coefficient (CC) calculated between the
fragmentation pattern of the anchored peak and the selected peak. In the case of this figure, the
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Pearson's CC and cosign theta CC are high enough but the Spearman's order CC is negative value.
Therefore, it didn't pass the matching parameter setting where the negative Spearman's CC value was
rejected. The Compare tab helps users not only to judge the validity of the editing operations, but also
to evaluate the alignment results and to investigate the better matching parameters suitable to the
input data.
 Creating a New Alignment
Select a peak on the alignment panel and press
lines.

button. The selected peak is surrounded by blue

It means that the peak is recognized as a new alignment group, but the selected peak is the only
member of the group. See the "Time" and "Peak" list.

Select the peak to be added to the alignment group, and click
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button.

Users can remove a peak from the alignment group. Select a peak in the alignment and press
button.

 Deleting the Alignment
As described in 3-6-1-1. First Alignment to find the Endogenous IS , the alignment of the selected
peak group (highlighted in blue) is deleted by clicking the "Delete" button. The peaks are not deleted
by this operation.
Alternatively, the alignment group is deleted if all the member peaks are removed by clicking
button.
 Merging Peaks
It often happens even in a good deconvolution algorithm that EI fragmented ions derived from a
single compound are distributed into two independent peaks. FragmentAlign provides a function to
merge such peaks and generate a new single peak.
Anchor a peak, select another peak, and press
button. A new peak is created at the averaged
retention time (index) of the two parent peaks. The parent peaks and the merged peaks are represented
in gray.

As the peak data is modified, users have to save the peak data in FragmentAlign format before saving
the alignment data. Select "Save Alignment Data" in the File menu and follow the message.
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The date and the time of the merging and the name of the parent peaks are attached to the "Comment"
field of the new peak. The comment is recognized on the Fragment Viewer window. The merged peak
is named automatically as "Merged*", where "*" is the sequential number in the data file.

The intensities of the fragment ions are the summation of those of the parent peaks.
The parent peaks are labeled to "Ingored" peak in the data file, but users are still allowed to use the
ignored peaks for alignment editing.
If one of the parent peaks (but not both of them) was a member of an alignment group, the merged
peak is assigned automatically as the member of the alignment.

Users can undo the peak merging as long as no other editing operations are performed. Click "Undo
Peak Merge" in the "Edit" menu.

 Merging Alignments
Users can merge two alignment groups into a single group. The function facilitates users to edit the
alignment results especially when a lot of samples were aligned.
Anchor a peak in an alignment group, and select another peak in another alignment group. Then click
button.
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When peaks form a same sample were included in the two parent groups, FragmentAlign
automatically assigns the peak having earlier retention time (index) to the member of merged group.
Such peak pair is highlighted with orange circle. Check the peak data and correct the result manually
if it's needed.

Click

to clear the orange circle.

3-6-2-3. Importing the Alignment Data of the Other Tools
The alignment data created by the other alignment tools can be imported into FragmentAlign to
further edit and curate the alignment results with the FragmentAlign GUIs. The importing data files
have to be prepared in the defined formats.
 Preparation of Importing Data File
For the importing function, FragmentAlign requires two types of the data files as follows.

1) Sample Data File
The peak data for each sample written in the FragmentAlign format.
2) Alignment Data File
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The tab-delimited text file describing the alignment matrix. The first row is the file names of the
sample data files, and the following rows are alignments including the peak indices of each sample.
The peak index number (starting with zero) have to be same as the appearance order of peak data in
the sample file. The cells in the matrix where no peak is included is filled with the value "-1".

 Data Importing
Select "Import Alignment" in the "File" menu. The following window appears.

Select the alignment data file and the sample data files by clicking
displayed.

icons. The selected files are

Select the time scale (retention time or retention index). Then press "Do Import Alignment" button.
The alignment data is displayed on the Peak Alignment Window.
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Close the Import Alignment window.
Users can edit and save the alignment data with the GUIs of FragmentAlign.
Tutorial:
Find the tutorial files in the "ImportAlignment" folder in the tutorial data (see 1-3. Tutorials). Select
"AlignmentData.txt" as the alignment file, and three other "FA_" files as the sample data file. Select
"Retention Index" for the Time Scale and execute the importing.

3-6-2-4. Annotation Functions of the Peaks and the Alignments
 Searching with the Standard Compound Library
Similar function is already described at the Peak Viewer section (see 3-5-4. Searching with Standard
Compound Library). The function is essentially the same but there are some differences. Users can
choose the peak or the alignment as the query of the library searching.
Click "Search" tab on the "Tools" window. Choose "This Peak" or "This Alignment" from the
pull-down menu. Input the cutoff value and then press "Search" button.

Select row(s) of the result table, and click "Copy Lables To Clipboard" button. You can paste the
result into the comment field of the Fragment Viewer or anywhere.
 Annotation
The function is almost the same as that of Peak Viewer (see 3-5-5. Annotation - Library Searching for
All Peaks). Be careful that the query of the searching is the all "Alignments".
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The results are temporarily stored at the comments of the alignment groups. Save the file by "Save
Alignment Data" menu.

3-6-2-5. Other Functions
 Getting a FragmentAlign formatted text
Users can get the data of the selected peak or alignment in the FragmentAlign format. This function
helps to prepare the "Standard Compound Library" file.
Click "Text Format" tab at the "Tools" window. Choose "This Peak" or "This Alignment" from the
pull-down list and click "Get Formatted Text" button. The results are displayed in the text area.

If the checkbox is selected, the intensities of the mass fragments are normalized so that the maximum
intensity is adjusted to the user input (default value is 999).
The users can copy the results by clicking "Copy to Clipboard" button.

3-7. Standard Compound Library
To use the Standard Compound Library for identifying and/or annotating the metabolite peaks and
alignments, users have to choose the library data file and set the parameters to compare the similarity
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of the EI fragment patterns. Once the library is setup after running the FragmentAlign, the setting is
shared through the all functions in the software.
Click "Std. Library" button on the FragmentAlign Main Window.
The following window appears.

Alternatively, users can access to the Standard Compound Library window from the Peak View
window (see page 15 and 16) and Peak Alignment window (see page 35)
Select a proper file format from the "Format" pull-down list and click "Open Library" button to select
a library data file.

A sample library named " StdCompLibData_example.txt" is available in the "TutorialData" folder in
the FragmentAlign distribution package. The library file should be written in the FragmentAlign
format too.
The pattern of EI fragment ions are displayed on the lower panel when a standard chemical data is
selected in the compound list (upper panel).
Users can search the compounds by name by entering the keywords in the text box.
Tutorial:
Open the library file named "StdCompLibData_example.txt" in the "StandardLibrary" folder of the
tutorial data (see 1-3. Tutorials).
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3-7-1. Setting Matching Parameters
Click settings button.

The following window appears.
A
B
C
D
E
F
G
H
I
J
K
L

Set the parameters.
 A) Retention Index Range for Searching
If the differences of the retention indices between the two peaks comparing is greater than the setting
value, the peaks are evaluated as not matching (rejected). If users want to ignore the retention index
for the evaluation, set a larger value than the maximum value of retention index.
 B) Maximum Fragment Number to Compare
If set this parameter as "20", up to 20 highest ions are included in the matching evaluations. The
limitation of the number of ion fragments prevents under estimations of matching score for peaks
with large number of ion fragments.
 C) Minimum Fragment number
If the peak has smaller number of the ion fragments than the setting value, the peaks are rejected.
 D-F) Weights (proportions) for Matching Score Estimations
In FragmentAlign, the matching score is calculated as followings.
Score = 1000 *
(Pearson's Correlation Coefficients
x parameter D
cosθ Correlation Coefficients
x parameter E
Spearman's Correlation Coefficients x parameter F )
(parameter D + parameter E + parameter F)

+
+
/

The matching similarity score is expressed as a combination of three kinds of correlation coefficients,
and the users can define the proportion of the correlation coefficients. The score is normalized so that
the maximum value is 1000.
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 G-I) Parameters to Reject Matching
The parameter G to J defines the threshold value of each kind of correlation coefficient. If one of the
correlation coefficient underwent the threshold value, it is estimated as rejected even if the proportion
of the correlation coefficient is set to zero at the parameter D to F.
 J) Ratio of Common Fragments / All Fragments
The ratio is calculated as follows.

intensity

Fragment ions of peak A

m/z

intensity

Fragment ions of peak B

m/z
Common fragments = 4
All fragments = 7
Ratio = 4/7 = 0.571

If the ratio is smaller than the threshold (parameter J) it is rejected.
 K) m/z range to Compare
Set the range of m/z values included in the matching evaluations.
 L) Ignore m/z s
The m/z values are excluded from the matching evaluations. Separate the values by comma if users
want to exclude more than one m/z value. It helps to exclude the ion fragment usually detected such
as ions derived from tri-methyl silane used for the derivatization of the metabolites.

4. Peak Alignment Algorithm
The peak alignment algorithm is described here. The java classes for the alignment and the source
code of it are provided as the jar file named "FAlign.jar" in the installation package.
Here the total number of sample is defined as N (0 ≤ i ≤ N) and the total peak number of ith sample is
defined as M(i) (0 ≤ j(i) ≤ M(i)). The jth peak of ith sample is described as P(i, j(i)). In the similar way,
peak intensity, retention time or retention index and fragmentation pattern is described here I(i, j(i)),
T(i, j(i)) and F(i, j(i)), respectively. Final matrix is defined as A, which holds the peak P(i, j(i)) in an
element A(i, k), where the row number of A is MA (0 ≤ k ≤ MA).
 Step1
Peaks of first sample (P(0,0) ... P(0,M(0))) are inserted into the first column of final matrix A
(A(0,0) ... A(0,M(0))). At this time, row number of A is equal to that of M(0).
 Step2
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Peaks of the next sample are inserted into A. If the fragmentation pattern of a peak F(1, j(1)) has
highest similarity parameter to A(0, k) under given conditions (described below), P(1, j(1)) is
inserted into A(1, k), else P(1, j(1)) is inserted into column 1 of newly added row of A, A(1, MA + 1).
This process is applied for all peaks of this sample. If higher similarity parameter is found for peak
P(1, j(m)) to the same A(0, k) than previously inserted peak P(1, j(n)) into A(1, k), A(1, k) is replaced
by P(1, j(m)).
Similarity parameter (S) between two fragmentation patterns is estimated under given condition
parameters. These condition parameters are set by users. Parentheses show the settings which are
given as defaults in FAlign.
Trange:
FminN:
PPearson:
Pcos:
PSpearman:
CPearson:
Ccos:
CSpearman:
FminR:

range of retention time or retention index. (2)
minimum number of ions in the fragment data. (5)
proportion of Pearson's correlation coefficient. (0)
proportion of cosƟ correlation coefficient. (1)
proportion of Spearman's order correlation coefficient. (1)
cutoff value of Pearsion's correlation coefficient. (0)
cutoff value of cosƟ correlation coefficient. (0.5)
cutoff value of Spearman's order correlation coefficient. (0)
minimum ratio of commonly detected m/z number to total m/z number. (0.2)

The similarity of the fragment patterns of the two peaks are estimated if the distance of retention
times or retention indices of two is in the range of Trange and fragment numbers of both are more than
or equal to FminN, else the similarity parameter S is -1. Similarity parameters are calculated as
following equation.
S = Pearson * PPearson + Cos * Pcos + Spearman * PSpearman
, where Pearson, Cos, and Spearman mean Pearson's, cosƟ, and Spearman's order correlation
coefficients, respectively.
If one of conditions is in the case of following, S is set to -1.
1) Pearson < CPearson
2) Cos < Ccos
3) Spearman < CSpearman
4) Ratio of commonly detected m/z number to total m/z number < FminR
 Step3
Step2 is continued for all samples, whereas the similarity parameter (S) for fragmentation pattern of a
peak F(i, j(i)) is first estimated against all of the peaks in a row of A, A(0, k) ... A(i-1, k), and the
highest S is adopted to the evaluation against the row k.
 Step4
Finally the rows of final matrix A are sorted by the averaged retention time of the peaks inserted in
the row.

Running time of this algorithm is proportional to the total number of the peaks and time range, and
proportional to square of the sample number.

5. File Format
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5-1. FragmentAlign format
The data files that are processed with FragmentAlign have to be written in the FragmentAlign format
(FA format), which is a kind of MSP file format defined by National Institute of Standards and
Technology (NIST, http://www.nist.gov/, see the latest version of NIST MS Search User Guide at
http://chemdata.nist.gov/mass-spc/ms-search/). The NIST MSP format is simple and does not
define the description of the parameters concerning to the chromatographic characteristics such as
retention time of the peak. Furthermore, the format allows several ways of description about ion data
detected (mass value and intensity). Therefore, we re-defined the "FragmentAlign format" to process
the data in the software.

An example of FragmentAlign format

- The information of each peak must start with the Field title "NAME:" and some name is required.
- The retention time must be written in the "Synon: RT:" field. The unit is second and the label "sec"
have to be appended after the value without space.
- The retention index can be written in the "Synon: RI:" field.
- Comments can be written in the "Comments:" field.
- The field "DB#:" is used for peak id. It is recommended that the value is same as the appearance
order of the peak in the data file.
- The total number of EI fragment ion must be written in the "Num Peaks: " field.
- In the following lines of the "Num Peaks: " field, the mass value and the intensity of each ion must
be described with separated by space and the ions must be concatenated with semicolon ";". The
ions can be written in multiple lines. The value of mass and intensity can be described in real
number. The peak intensity is the sum of the ion intensities, and it is calculated automatically by
FragmentAlign after loading the file.
The field named "Synon: Ignored" will be added when the peaks are merged. It is not recommended
to the users to add and edit the field manually (see Merging Peaks).
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5-2. CSV File Format for Data Deconvolution
This is the file format describing a raw mass chromatogram data. The file must be prepared in comma
separated vector (CSV) format. The format is the same as that of CSV file exported by the
ChromaTOF software (LECO Corporation). The file can be applied to the deconvolution function
(see 3-3. Deconvolution of raw data in CSV file).
To help better understandings, we describe here how to prepare the file with Microsoft Excel.

The first row is the header line. Enter "Scan" and "Time" in the A1 and B1 cell, respectively. The
following cells in the first row are the mass values. Only the nominal mass value is acceptable.
The following rows are the data body. The column A is scan number in sequential integer. The
column B is the retention time of the gas chromatography. The values of column B can be given in
real number, and the unit should be second. The following column of each scan number is the
intensity of the mass described in the header line. The intensity can be written in real number and the
exponential expression is acceptable. The value zero is required if there was no data.
Save the data as CSV file.

5-3. Alignment Data for Importing
The file is used for importing the alignment data which is generated by the other software (see 3-6-2-3.
Importing the Alignment Data of the Other Tools).

The first row is the file names of the sample data files and the following rows are alignments
including the peak indices of each sample. The peak index number (starting with zero) has to be same
as the appearance order of peak data in the sample file. The cells in the matrix where no peak is
included is filled with the value "-1".
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6. Other Information
6-1. Version History
1.18.1 12 Mar / 2013
- Licensing policy changed.
1.18 24 May / 2012
- The data import function supports the format of AMDIS intermediate file ".ELU".
1.17 03 Oct / 2011
- The initial public version released.
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